Licensed Home Care Services Agency Statistical Report and Registration Forms on Universal Data

Collection System (UDCS) Instructions

Please see Attachment A at the end of this document — it contains descriptions to all items on the tool bars
located on the top of the Report Manager worksheets.

General Information:

¢ Enter information in the blank white fields. All other fields (pink, lavender, and brown) are read-only
fields. You can leave white fields blank if you have nothing to report — you do not have to enter zeros.

o A few fields are required. If they are left blank, you will not be able to submit the report. The field

header will indicate that the field is required.
¢ Some fields require a Yes or No answer. You must double click on the blank field and choose Yes or

No from the box.

e Some forms have validation edits to ensure accurate information is collected. The validation edits are

described in these instructions.

Note: This documentation has been updated from previous versions. Images may be from previous

report years. Dates in the text have been updated for the current report year (2023).

To Begin:

Once you have downloaded the Report Manager software and report shell (see the separate downloading

instruction document):

e To start a new report, click on the Start New Report icon or to resume working on a previously saved
report click on the Open Existing Report icon.

Start Report

Open
Existing
Report

Start

Report

Cancel
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure
Report Organization. In this box, you will select your organizations name from the drop-down box in the
organization line. If your organization is not listed in the drop-down click on the box that states Organization
Not found In List for further instruction. In region section you will have to select statewide. Then click OK.

Configure Report Organization x

Organization v

Region
Submission Period Annual

Report Duration 01/01/2021 - 12/31/2021

Organization Not Found In List OK Cancel

You will then see a report configuration box. Click the Next tab in the bottom right corner.

85! Report Configuration

Report Types

Select LHCSA.

Class Code Line Number
999810002 [1 LHCSA - LHCSA

Cancel . Next >
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A second report configuration box then appears with the title CheckBox List Panel. This is where you will

select the counties that your agency serves. For example, if you have served patients for this reporting year
in only three counties you would ONLY pick those three counties in this county list. Once you have done so,

click the Next tab at the bottom right corner.

65 Report Configuration

CheckBox List Panel

Class Code Line Number

mazom| |1

mszoooo| |2

mazom| |3

mszoooo| |4

mszom| |5

mszoooo| |6

mszom| |?

mszoooo| |s

mszoooo| |1o

99982<mo| |11

mszoooo| |1z

99982<mo| |13

mszoooo| |14

99982<mo| |15

|
|
|
|
|
|
|
|
| mszom| |9
|
|
|
|
|
|
|

mszoooo| |16

Oo
Oo2
o3

o4-

Oos

[ o06-
Oor-
os-
Oog-

O1o-
Ou-
O12-
Oz-
O-
O1s-
16 -

Select the Counties for which you are reporting.

- ALBANY
- ALLEGANY

- BROOME

CATTARAGUS

- CAYUGA

CHAUTAUQUA

CHEMUNG

CHENANGO

CLINTON

COLUMBIA

CORTLAND

DELAWARE

DUTCHESS

ERIE

ESSEX

FRANKLIN
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A third report configuration box will appear once you have completed selecting your counties of service. Click
Finish in the bottom right-hand corner.

ﬂ Report Configuration

Report Configuration Complete

u |<Back||ﬁmsh|F

Important Note: After you have clicked finish, if you need to make a revision to the counties that you
have selected this can be done by selecting “Configure” and “Report Configuration” from the top
tool bar. After you have made the revision, you will be prompted to replace your current .pnp file with
the revised file. Click yes to replace the current file.

W Fle Edit View Action Notes Windows Search Help

4 |mmmm;mmmm-1 (120011234 : STATEWIDE : 2021 ADD
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General Information Form

The General Information Form is part of the Report Manager Software and collects information about your
organization that not only identifies you but enables the submission and certification of your report as well as
the successful transfer of your data to a data repository.

When you open the report, you will receive a pop-up box that requests that you fill in the General Information
Form. You must fill in the General Information Form prior to submitting the report.

8 General Information Validation Message = O X

Class Code Line Humber

Submision ype: — |
Submisson vear o i
Submision perid: [ ofon l
ocn: — !
Submitter 1D : | 0| [1000 | [120011234 |
Region 10 s f 1
Region Name: [ 9oz fravewoe )
Mame of Organization : [ q [10 | [HCBS TEST ORG NAME - 1 (120011234) |
Begin Date | o |34 | 120202021

End Date : | o s | 122201
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Contact Person

Class Code Line Number

Name : [ 54000] |3 | | o
Title : [ 54000 [« | | o
Telephone Number : [ 54000 5 | | &
Fax Number : [ s4000| [6 | | |

E-mail Address : | s4000] 7 | | o

Mailing Address
Class Code Line Number
Street Address : [ s4000] i1 | | o
ity : | 54000 12 | | o
State : | 54000 13 | | o
Zip Code : | 54000 14 | | |
Validate ~ Save | Cancel |

The General Information Form information section will be filled in for you. You only need to fill in the Contact
Person and Address sections.
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Form LSR1 - Agency Form

Form LSR1 - Agency Form collects agency location, contact information and other information.

LSR1 Agency Information Form

License Mumber

MNational Provider Identification Number

Federal Employer Identification Mumber (FEIN)

Agency Name

Street Address

City

State

Zip

Agency Phone Mumber

Contact Person Mame

Contact Person Email

There are two options for LHCSAs that serve patients in an Assisted Living Program

only complete the ALP LHCSA Statistical Report

Is this Agency an ALP LHCSA that also serves patients in the community?

(ALP): 0011
- If the ALP LHCSA serves patients in the community as well as ALP Patients, they must 0012
complete this report AND the ALP LHCSA Statistical Report

- If the ALP LHCSA EXCLUSIVELY serves ALP patients, DO NOT complete this report - 0013

Did this Agency serve patients during the report year?

0016

Does this Agency operate a Home Health Aide Training Program?

0018

Does this Agency operate a Personal Care Aide Training Program?

0019

Does this Agency serve waiver program (NHTD ar TBI) patients?

Are there any employees of this Agency that are represented by a collective bargaining
agreement?

Is this Agency a Fiscal Intermediary (FI) for the Consumer Directed Personal Assistance
Program (CDPAP)?

If yes, is this Agency EXCLUSIVELY a FI for CDPAP?

OR. is this Agency's Fl a separate line of business from your Home Care line of business?

Agency and Contact Information Section

All fields in this section, except for NPl number, are required fields. You will not be able to submit the

statistical report if this information is not filled in.

Important Note for ALP LHCSAs -
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The ALP LHCSA Statistical Report will be posted on the UDCS Platform this year and will include the
DOH Registration form.

If your LHCSA serves patients in an Assisted Living Program (ALP) there are two options:

e If your LHCSA serves patients in the community as well as ALP patients, you must submit both the
Annual LHCSA Statistical Report regarding your community patients and the Annual ALP LHCSA
Statistical Report regarding your ALP patients.

e |f your LHCSA EXCLUSIVELY serves patients in an ALP program, you only need to submit the
Annual ALP LHCSA Statistical Report — you do not need to submit any part of the annual LHCSA
Statistical Report.

Agency Information and Fls for CDPAP Sections
The fields in these sections require yes or no responses. You must double click on the blank space and the

box with the choices will appear.

ol YESMO Y

Search || |

Name

Yes
No

Current value for cell [
{no value has been assigned} Ok Cancel

Validation Edit — Your answer to the question “Did this agency serve patients during the report year?” on
row 16 of form LSR1 must match your answer to the question “Did this LHCSA provide patient care services
during the last year?” on row 4 of form LSR10.
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Form LSR2 — Patient Form

Form LSR2 - Patient Form collects patient demographic information, including discharges and referrals.

LSR2 Patient Form Patients/LO5 | Referred From | Discharged To
20000 20001 20002 20003 20004

Census on December 31 of the Report Year | 0001

Total Cases | 0002
Unduplicated Patient Count | 0003
0999

Total Unduplicated Patient Count from Services by
County Forms - L5RY

1-60 Days of Stay | 0004
61-120 Days of Stay | 0005
121 + Days of Stay | 0006
TOTAL

Hospitals
Physicians | 0013

Self/Family/Friends | 0014

Mursing Homes | 0015

CHHAsS | 0016

LTHHCPs | 0017

LHCSAs | 0018

Hospices | 0019

Adult Care Facilities | 0020

CASA/Local Social Services Districk | 0021
MLTC/MCOs | 0022

Local Health Department | 0023

Adult Protective Services | 0024

Death | 0025

Other | 0026

Describe "Other" Referrals and Discharges | 0027
TOTAL | 0030

Some of the totals on this form are automatically calculated — they are the lavender fields.
Patients Section
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Enter information for Patient Census. Enter the patient census as of December 31 of the report year. Patient
Census means the actual number of individual patients receiving services on December 31 of the report year
(12/31/23 for the 2023 report year).

Next, enter the total number of cases in the Total Cases field. A case is an episode of care with a start date
(admission) and an end date (discharge). Multiple types of service may be provided during an episode of
care. For an episode of care to count as a case for this report the admission date must be in this reporting
year or prior year(s), and the discharge date must be in this reporting year, or the patient must still be
receiving services at the end of the reporting year. A patient who has been seen only to be assessed for
personal care services should not be counted as a case, and these visits should not be reported.

A patient sometimes represents more than one case. However, DO NOT count a patient as a new case if
any of the following conditions apply:
e The patient’s age category was changed during the report year.
e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.
e The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Validation Edit - The number of cases entered on row 2 of LSR2 must match the total of the “Referred
From” column on row 30 of LSR2.

Enter the Unduplicated Patient Count in the next field. This is the total number of discrete individual
patients that your agency has served in the year, regardless of the number of admissions and discharges
that patient may have had. A patient is only counted once regardless of the number of cases they represent.

To recap, if a patient is receiving care on 12/31/2023 they will be included in the patient census count. If they
had two admissions during the year, they would count as two cases but as only one unduplicated patient.

Validation Edit - The unduplicated patient count entered on row 3 of LSR2 must match the total of the
unduplicated patients reported on forms LSR7 — Services by County Form. This total is displayed on row 999
in the first section of LSR2 — Patient Form.

Length of Stay Section

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or
case. Length of stay should be calculated from the date the patient was initially admitted for an episode of
care, regardless of the year of admission, to the date they were discharged. For example, if a patient was
admitted on 12/30/2022 and discharged on 1/10/2023 her LOS is 12 days. Count the 2 days in 2022 and the
10 days in 2023 to arrive at a 12-day LOS. Patients that were discharged to a hospital or RHCF and
readmitted to the agency within 30 days with the same illness or diagnosis should NOT be counted in the
length of stay section.

Validation Edit - The total number of discharges calculated from the LOS entries on row 10 of LSR2 must
match the total number of discharges calculated from the “Discharged To” section on row 30 of LSR2.

Referrals and Discharges Section

The next section collects patient referral and discharge information. In the “Referred From” column enter the
number of cases served by your agency that have been referred from each of the designated sources
regardless of their start of service date. This means that if you are serving a case in 2023 that was referred to
your agency in 2022, that case should be counted. Patients that were discharged to a hospital or RHCF and
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readmitted to the agency within 30 days with the same illness or diagnosis should not be counted in the
discharge section.

In the “Discharged To” column enter the number of cases discharged during the reporting year to specific
destinations.
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Form LSR3 and LSR4 — Revenue Form
Form LSR3 and LSR4 — Revenue Form has two sections.

LSR3 - Contract Revenue Form collects information about revenue received from contracts with other
agencies to perform services for their patients or provide equipment to their patients.

LSR4 - Direct Revenue Form collects data on revenue from services provided to patients directly served by
your agency (i.e. services are not provided on behalf of another agency). Direct services may include private
pay, commercial insurance, and worker’s compensation cases.

L5R2 and L5R4 Revenue Form Visits Hours Gross Revenue
34000 34001 34002 34003 34004

Did your Agency perform services, or provide equipment to
patients during the report year?

Mursing Services

Private Duty Mursing Services

Community Health Work Services

Medical Social Work Services

Case Management/Care Management Services
Audiology, Mutrition, and Therapy Services
Home Health Aide Services

Personal Care Aide Services

10
IV Infusion Therapy Services | 0011
HHA Training Program | 0012

PCA Training Program | 0013
Waiver Services | 0014

Telehealth Monitoring | 0015
Assistive Technology | 0016
Durable Medical Equipment | 0017
Other Services | 0018

TOTAL | 0020

Homemaker and Housekeeper Services
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LSR4 - Direct Services

Enter the number of direct visits or hours and revenue for
each service:

Visits Hours Gross Revenue
Mursing Services | 0021
Private Duty Mursing Services | 0022
Community Health Work Services | 0023
Medical Social Work Services | 0024
Case Management/Care Management Services | 0025
Audiology, Mutrition, and Therapy Services | 0027
Home Health Aide | 0028
Personal Care Aide | 0029
Homemaker and Housekeeper Services | 0030
I Infusion Therapy Services | 0031
HHA Training Program | 0032
PCA Training Program | 0033
Waiver Services | 0034
Telehealth Monitoring | 0035
Assistive Technology | 0036
Durable Medical Equipment | 0037
Other Services | 0038
TOTAL | 0040

Some of the totals on this form are automatically calculated — they are the lavender fields.

Please note that data on Nursing Services is collected as visits, instead of hours. If your agency records
Nursing Services in hours, please count 2.5 hours as 1 visit.

Contracted Services Section

Begin by answering the Perform Services Question - If your agency DID NOT perform services for, or
provide equipment to, the patients of other agencies under contract during the report year, answer the first
question “no” and move down to the Direct Services section of the form. You may leave the columns blank
and do not need to enter Os in these columns.

If your agency DID perform services for or provide equipment to the patients of other agencies under
contract, enter “yes” for the first question. Enter the number of contract hours and revenue by the type of
service if you have contracted with another agency, usually a CHHA or an MLTC plan, to provide service on
their behalf.

Direct Services Section

Enter the number of hours and revenue by the type of service.

If your agency did not provide any services directly to any patients, leave the columns blank (you do not have
to enter 0Os).

For both the Contracted Services and the Direct Services - the Gross Revenue is the total revenue received
for the services or equipment provided before any deductions or allowances.

Validation Edit — If there is an entry made in the hours or visits column, there must be a corresponding entry
made in the gross revenue column.
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LSR5 — Cost Form

LSR5 - Cost Form - collects data on costs for providing services to patients. Costs are divided into direct
and indirect costs.

Direct costs are costs that are clearly associated with the provision of home care patient services. Examples
of direct costs are staff wages, transportation costs, consumable supplies such as gloves and masks, and
the cost of providing in-service training to aides.

LSR5 Cost Form
Report Type : LHCSA

LSR5 Cost Form Cost
50000 50001 50002

Direct Costs - Include Wages

Enter the Costs related to the delivery of each
service type:

Mursing Services | 0001

Private Duty Mursing Services | 0002

Community Health Work Services | 0003

Medical Social Work Services | 0004

Case Management/Care Management Services | 0005
Audiology, Mutrition, and Therapy Services | 0007
Home Health Aide Services | 0008

Personal Care Aide Services | 0009

Homemaker and Housekeeper Services | 0010

IV Infusion Therapy Services | 0011

HHA Training Program | 0012

PCA Training Program | 0013

Waiver Services | 0014

Telehealth Monitoring | 0015

Assistive Technology | 0016

Durable Medical Equipment | 0017

Other Services | 0018

TOTAL DIRECT COSTS | 0020

Indirect costs are fringe benefits and payroll taxes as well as costs for activities and materials that are used
by the entire agency.

The indirect costs are broken out by fringe benefits and other indirect costs, such as administrative and
general costs, capital and related costs, and other operating costs.
¢ Administrative and General costs are expenses for activities and materials that are used to administer
your business. Examples are rent, utilities, and office supplies.
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e Capital and Related costs are onetime costs for construction, major repairs to real estate owned by

the agency, etc.

Social Security

Insurance - Life/Health

Pension and Retirement

Workers Compensation

Unemployment Insurance

Disability Insurance

Supplemental Wages

Employee Physicals

Other

Administrative and General Costs

Capital and Related Costs

Other Operating Costs

TOTAL INDIRECT COSTS

TOTAL DIRECT + INDIRECT COSTS

Some of the totals on this form are automatically calculated — they are the lavender fields.
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LSR6 - Staff and Wages Form

LSR6 - Staff and Wages Form - collects information by staff type for full time and hourly staff at two
different dates during the reporting year and the total number of W2s issued, hours worked, wages, and
fringe benefits.

LSR6 Staff and Wages Form
Report Type : LHCSA

Lowest Hourly Highest
Count of Full Count of Count of Full Count of . Wages + Average .
LSR6 Staff and Wages Form Time Staff on | Hourly Staff | Time Staff on | Hourly Staff cw."t of W2z | Total Hours Total Wages | Total Fr!nge Fringes Hourly Rate Rate Paid for H\.:urly Rate
issued for the Year | for the Year Benefits each Staff Paid for each
Apr1 on Apr1 Oct1 on Oct 1 (Calculated) (Calculated) Ty
ype Staff Type
60000 60001 60002 60003 60004 60005 60008 60006 60007 60009 600010 600011 600012 600013
Enter the information for each of the
following staff types:
Administrators | 0001
Other Administrative Staff | 0002
MNursing Supervisors | 0003
RMNs | 0004

LPNs | 0005

Private Duty Nurses | 0006

Community Health Workers | 0007
Medical Social Workers | 0008

Case Managers/Care Managers | 0009
Audiologists, Nutritionists, and Therapists | 0011
Home Health Aides | 0012

Personal Care Aides | 0013
Homemakers and Housekeepers | 0014
Other staff | 0015

TOTAL | 0020

Some of the totals on this form are automatically calculated — they are the lavender fields.

Enter the number of full-time and hourly staff at your agency on April 1 and October 1 of the reporting year.
The current definition of a full-time staff is someone who works an average of 30 or more hours a week and
130 hours or more per month.

Validation Edit — the number of HHAs entered in each of the 4 first columns must not exceed 17,000.
Validation Edit — the number of PCAs entered in each of the 4 first columns must not exceed 17,000.
Enter the number of W2s issued during the year for each staff type.

Validation Edit — the total number of W2s must not exceed 25,000.

Enter the total hours worked, total wages paid, and total fringe benefits paid for each staff type. The amount
of wages plus fringe benefits will be calculated in the first lavender column. The second lavender column will
divide the total wages (not including fringe benefits) by the total number of hours to calculate an average

hourly wage. In the next two columns, enter the lowest hourly rate paid and the highest hourly rate paid for
each staff type.
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LSR7- Services by County Form

LSR7 - Services by County Form - collects data on services provided by county. There is a sheet for each
county that you chose when you started the report. The LSR7 worksheets were put at the end of the list of
worksheets on the left-hand side of the screen.

LSRT7 Albany - Services By County Unduplicated.. ~ Under Age 21  Visits/Hours Und... Age 21-64 Visits/Hours Age... Age 65+ Hours 65+ Nurse Family P.. | Nurse Family P...
70000 70001 70002 70003 70004 70005 70006 70013 70014 70011 70012
Albany County Unduplicated Pa... Unduplicated Pa... Unduplicated ...

Unduplicated Patient Count | 01001
Number of new admissions during the reporting year 01002
Enter Cases, Visits, and Hours for each service type Cases Under 21 Visits Under 21 Cases 21-64 Visits 21-64 Cases 65+ Visits 65+ Cases NFP Visits NFP
Nursing Services | 01003
Cases Under 21 Hours Under 21 Cases 21-64 Hours 21-64 Cases 65+ Hours 65+ Total Cases Total Hours
Private Duty Nursing Services 01004
Community Health Work Services | 01005
Medical Social Work Services 01006
Case M. fCare Manag Services | 01007
Audiology, Nutrition, andTherapy Services | 01009
Home Health Aide Services | 01010
Personal Care Aide Services | 01011

Homemaker and Housekeeper Services | 01012

IV Infusion Therapy Services | 01013

Waiver Services | 01014

Telehealth Monitoring | 01015

Assistive Technology | 01016

Dubable Medical Equipment 01017

Other | 01018

Total Cases - Includes Nursing Services (Calculated) 01040

Some of the totals on this form are automatically calculated — they are the lavender fields.
For each County that your agency provides services:

Enter the number of unduplicated patients in each of the age cohorts:
e Under age 21
o Age 21-64
e Age 65+
These amounts are automatically calculated in the lavender field in the first column.

Enter the number of new admissions during the report year.

Validation Edit - The amount entered as new admissions must be less than or equal to the unduplicated
patient count.

An unduplicated patient is an individual who has received at least one episode of care and may have
received more than one. Regardless of the number of episodes in the reporting year, the individual is only
counted once. We are asking for the unduplicated patient count to be broken out in cohorts of age groups.
Please count the age of the patient at the first episode of service (if service was initiated during the report
year), or if the patient started service in a prior year count their age at the beginning of the year.

New admissions are patients that have been admitted to the agency during the reporting year. Patients that
were admitted at a previous time during the report year (or in prior years) and discharged and were admitted
again during the report year should count as a new admission at the time of admission, with the following
exceptions:
DO NOT count a patient as a new admission if any of the following conditions apply:

e The patient’s age category was changed during the report year.
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e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.

¢ The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Nursing services captures data about nursing services provided to patients in the selected county. The data
is then broken out by cases and visits and age category. If your agency records Nursing Services in hours,
please count 2.5 hours as 1 visit. In addition, if your agency is part of the Nurse Family Partnership — the
number of nursing service cases and visits should be recorded in the selected county. The Nurse Family
Partnership is a program in which nurse home visitors work with low-income young women who are
pregnant with their first child, helping these vulnerable young clients achieve healthier pregnancies and
births, stronger child development, and a path toward economic self-sufficiency.

All other services provided to patients in the selected county must be recorded below the Nursing Services
row. The data is then broken out by cases and hours and age category.

A case is an episode of service with a start date (admission) and an end date (discharge). Multiple services
may be provided during an episode of service. For an episode of service to count as a case for this report the
admission date must be in this reporting year or prior year(s), and the discharge date must be in this
reporting year, or the patient must still be receiving services at the end of the reporting year. A patient who
has been seen only to be assessed for personal care services should not be counted as a case and these
visits should not be reported.

A patient sometimes represents more than one case. However, DO NOT count a patient as a new case if
any of the following conditions apply:
e The patient’s age category was changed during the report year.
e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.
e The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Validation Edit - If you enter an amount in the “Cases” column you must enter an amount in the
corresponding “Hours” column. Also, if you enter an amount in the “Hours” column, you must enter an
amount in the corresponding “Cases” column.

Validation Edit - If you enter amounts in the cases columns you must have an amount entered in the

unduplicated patient count. Conversely, if you have an unduplicated patient count, you must have amounts
entered under cases.
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LSR7A — Wellcare Form

LSR7A — Wellcare Form - collects data about Wellcare services provided to patients. Wellcare services
include services which have as their primary purpose the prevention of iliness and obtaining optimum health
for their recipients. Examples of such services are nurses performing lead screening assessments, providing
maternal and child health education, or following up on communicable diseases.

Only County-Operated LHCSAs that provided Wellcare services need to complete this form.

LSR7A Wellcare Services Cases Visits/Hours
74000 74001 74006 74007

COUNTY HEALTH
DEPARTMENTS ONLY

Double Click below to
Choose the County:

County 00001

Enter Wellcare Cases, Visits,
and Hours for each age group
in each service type

NURSES Cases Visits
Less than 1 Year of Age | 00002
1-5 Years of Age 00003
6-20 Years of Age 00021
21-64 Years of Age 00022
65+ Years of Age 00008
Total 00010

PRIVATE DUTY NURSES Cases Hours
Less than 1 Year of Age 00012
1-5 Years of Age 00013
6-20 Years of Age 00023
21-64 Years of Age 00024
65+ Years of Age 00018
Total 00020

Some of the totals on this form are automatically calculated — they are the lavender fields.

Nursing services captures data about nursing services provided to patients in the selected county. The data
is then broken out by cases and visits. If your agency records Nursing Services in hours, please count 2.5
hours as 1 visit.

Private Duty Nursing Services captures data about nursing services provided to patients in the selected
county. The data is then broken out by cases and hours.
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LSR8 — Contracts Form

LSR8 - Contracts Form - collects information on your agency’s contracts to provide services on behalf of
another agency.

LSR8 Contract Form
Report Type : LHCSA

I
LSR8 Contract Form License/Op Agency HHA Service | Rate Paid.fcr PCA Service | Rate Paid.for
Cert No. Hours HHA Services Hours PCA Services
80000 80001 80002 80003 80004 80005 80006 80007
Yes/No
Did your agency provide Aide services
for patients of another agency under | 9999
contract?

Enter Contract information for services License/Op HHA Service  Rate Paid for  PCA Service  Rate Paid for
performed for other agencies/facilities Cert Number Bosncy Hours HHA Services Hours PCA Services

Contract Mo. 1| 0001

Contract Mo. 2 | 0002

Contract Mo. 3 | 0003

Contract No. 4 | 0004

Contract Mo. 5| 0005

Contract No. &6 | 0006

Contract No. 7 | 0007

Contract No. 8 | 0008

Contract No. 8 | 0009

Contract Mo. 10| 0010

If your agency did not have any contracts to provide services for another agency, answer No to the first
question, and you are now finished with this form.

If your agency did have contracts to provide services on behalf of another agency, answer Yes to the first
question, and enter the information for the contract(s).

If it is available, enter the license number/operating certificate number for the agency with whom you are
contracting. CHHAs and Hospices will have operating certificate numbers. Other organizations may not have
an operating certificate number. Enter N/A if the organization does not have an operating certificate or
license number.

Operating Certificate numbers can be found in the Home Care section on the Profiles webpage
https://profiles.health.ny.gov/home care/index. Hover the mouse at the Home Care tab and you will see
several ways to search for an agency. Once you find the agency you are looking for, click on the overview
tab and open the administrative section.

Enter the number of HHA and PCA hours of service you provided under this contract and the amount your
agency was paid per hour of service.

If the requested information for a given contract changed during the reporting year, enter it as two or more
separate contracts.
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LSRI9WFA — Workforce Form A

LSROWFA — Workforce Form A - collects information on admissions and the number of cases by
authorized hours per week for all services.

LSROWFA Waorkforce Form A
Report Type : LHCSA

LSROWFA Workforce Form A Amount April 1 October 1
50001 90002 50003 90004 50005

Admission Information

How many times during this

reporting year was your agency 0001
closed to admissions?

How many cases did your agency
have during the report year where
you were unable to fill the total hours
approved for the case?

0002

How many cases was your agency

unable to accept on April 1 and Oct 0003
1 of the report year?

MNo. of Cases by Hours Per Week

for ALL Services

Using your caseload of April 1 and
October 1, how many cases were
authorized for:

Mo. of Cases  Mo. of Caszes
on April 1 on Oct 1

1-10 hours per week 0010
11-20 hours per week 0011
21-30 hours per week 0012
31-40 hours per week 0013

40+ hours per week 0014

Mo, of Live-in Aide Cases 0015

An agency is closed to admissions when the agency is not accepting any new patients. This would not
include times during the reporting year when an agency receives a referral list, fills cases it is able to, and
does not take cases it is unable to. However, if the agency is not accepting any new cases due to reasons
such as staffing and scheduling constraints, it should be included in this count. Do not include days, such as
holidays, if the agency would not normally accept a new case on that day.

An agency is unable to fill the total hours approved for a case if the case is approved for a certain
number of hours, but the agency is not able to fill the total number of approved hours with its current
workforce for any reason. Cases that are unfilled because someone calls out of work one day should not be
included in the response.

Send questions to hcstatrpts@health.ny.gov pg. 21



LSR9WFB — Workforce Form B

LSRO9WFB — Workforce Form B - collects information on number of staff employed and assigned to cases,
and the number of open positions at two points during the year. This form also collects the number of staff
that have been employed by your agency for the full report year and the number of staff that have left your
agency during the report year.

LSROWFE Workforce Form B
Report Type : LHCSA

Count of Staff
Count of Staff Count of Staff Count of Count of Staff Count of Staff | that left the
Employed on Assigned Open Employed on Count of Staff | Count of Open Employed for | Agency for
LSROWFB Workforce Form B

Oct 1 (From Assigned Positions on

April 1 (From Cases on April | Positions on the full Report | any reason

LSR6) 1 April 1 LSRE) Cases on Oct 1 Oct1 Year during the
report year
91001 91002 91003 91004 91005 91006 91007 91008 91009 91010
Staffing
Enter the information for each of the following
staff types:

Administrators | 0001

Other Administrative Staff | 0002
MNursing Supervisors | 0003

RNs | 0004

LPMs | 0005

Private Duty Murses | 0006

Community Health Workers | 0007
Medical Social Workers | 0008

Case Managers/Care Managers | 0009
Audiologists, Nutritionists, and Therapists | 0011
Home Health Aides | 0012

Personal Care Aides | 0013
Homemakers and Housekeepers | 0014
Other Staff | 0015

The number of staff employed on April 1 and October 1 is totaled (count of full-time staff plus count of hourly
staff) and forwarded from form LSR6 — Staff and Wages Form.

o Enter the number of staff assigned to cases on April 1 and October 1 of the reporting year. This
means staff that have cases assigned to them as of that date, not just staff actually working a case on
that date. For staff not providing direct care, such as administrators or administrative staff, enter a “0”
in the response.

e Enter the number of Open positions on April 1 and October 1 of the reporting year. A position is
considered open when an agency has advertised for a position, but it is not filled. This includes both
hourly and full-time positions. If an agency is continuously recruiting for any of the job categories, it
should quantify the number of workers it would need to hire to be considered fully staffed in that
category.

e Enter the number of staff (full time and hourly) that have remained employed by your agency for the
full report year or more. If an employee is terminated and rehired during the report year, they should
not be included in this total.

o Enter the number of staff (full time and hourly) that have left your agency (no longer employed by
your agency) for any reason during the reporting year. This is a count of workers who left their
position for any reason — voluntary or involuntary — excluding promotions.
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LSR9WFC — Workforce Form C

LSROWFC — Workforce Form C - collects employee benefit information for four types of employees, and
non-wage supports for all staff.

Hoememakers

Murses HHAs PCAs and
Housekeepers

LSROWFC Workforce Form C

92001

How many employees are
enrolled in employer-provided
health insurance as of October
17

How many employees have paid
sick/vacation leave as of 0004
October 17

How many employees have
access to employer sponsored
retirement plans as of October
17

How many employees have
short term disability insurance
which the agency pays at least 0006
part of the premium as of
October 17

How many employees have filed
Workers Compensation claims 0007
during the reporting year?
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Transportation Support | 0008
Childcare Support | 0009
Mentoring | 0010

Benefit Assistance | 0011
Scholarships | 0012

Does the agency pay increased
wages for employees filling
cases on weekends, holidays, or
for complex cases?

0014

Does the agency offer
employer-provided health | 0015
insurance?

Employees that receive health insurance or retirement plan benefits through the union, if the agency pays
into the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored
retirement plan.

Short-term disability insurance may include the required coverage under New York State law or
supplemental coverage that the agency offers.
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LSR10 — Registration Form

LSR10 — Registration Form - collects an attestation that indicates the LHCSA is currently operational and
serving patients. If the LHCSA has opened in the past year, you can report on the form that the LHCSA is not
yet operational and is currently not seeing patients.

Some fields on this form are required fields. You will not be able to submit the statistical report if this
information is not filled in.

The appropriate Governing Authority Representative must request that the LHCSA be registered with the
Department of Health for the upcoming calendar year.

LSR10 LHCSA Registration Form Response
100000 100001 100002

Today's Date 00001

LHCSA Operator Name 00002

LHCSA Administrator Name 00003

Did this LHCSA provide patient care services during the last year? 00004
Did this LHCSA provide patient care services during any portion this year? 00005
Does this LHCSA intend to provide patient care services in the next year? 00006

Has this LHCSA been open less than one year from today's date and has not served patients during this timeperiod?
Date LHCSA Opened

Has this LHCSA received payment for Nursing, HHA, or PCA services during the report year?

Do you wish to register this LHCSA with the NYS Dept of Health for the next calendar year? m_

By answering yes, | attest that all of the responses to this statistical report are true and correct to the best of my knowledge. 00013
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Validating the Statistical Report

You may, at any time, Validate the Sheet you are working on, or validate the entire Report. You must validate
the report before submitting it.

Go to the top tool bar and click on the drop-down box next to the green arrow.

B EDHE 7 ©O 5@ Q

ALP LHCSA STATISTICAL REPO RG NAME - 1 (120011234) : STATEWIDE : 2018 : PO1

VALIDATE CURRENT WORKSHEET

HEDHE

ALP LHCSA STATISTICAL RE

EIEACIOIPSE TN

NAME - 1 (120011234) : STATEWIDE : 2018 : P01

You can validate a worksheet at any time. You can also refresh the validation after it's been done once by
clicking the refresh circle in the details portion of the report. Because there are so many worksheets, it may
be easier to validate each worksheet once you've finished it. The results of the validation are in a table in the

details section of the worksheet. The message that says “Rule Passed Validation” is only referring to the cell
you are on — not the whole worksheet.

Details v

Worksheets Open Calculations Text Transfers Validation Results Submission Output

RULE PASSED VALIDATION Current Worksheet Refresh €3

The total of discharges in the "Length of Stay” section must match the total of discharges in the "Discharged To" column in the "Referrals and Discharges™ section. §

{20002.10} EEQ {20004.30} Filter : All Rules. ~| | Export as Excel
Sequence Identifier Level Error Left Value Operator Right Value Rule CriginalLogic

_ LSRZPATIENT u_m— The total of discharges in the "Length of Stay” section must match the total of discharges in the "Discharged To" column in the "Ref.. |{20002.10} EE...

12 LSR2PATIENT Critical ] EEQ The unduplicated patient count reported on LSR2 must match the total of unduplicated patients reported on LSR7 - County Forms -... |{20002.3} EEQ...

13 LSR2PATIENT Critical [l EEQ The number entered as total cases must match the total of the “Referred From” column in the Referrals and Discharges section. {20002.2} EEQ...

The details section is automatically set up to show all rules. It's only an error if there is a checkmark in the
error box.

Sequence Identifier Level Error Left Value Operator Right Value Rule

1 LSR2PATIENT Critical 1.0 EEQ 0 The total of discharges in the "Length of Stay" section must match the total of discharges in the "Discharged To" column

To see if you have any cells with errors — click on the filter in the details section and change it from “all rules”
to “critical errors”.

Details

Worksheets Open Calculati Text Transfers Validation Results Submission Output

CRITICAL : Operator [EEQ] : Left and Right values must be exactly equal - {.99} Variance is NOT considered equal.

The total of discharges in the "Length of Stay” section must match the total of discharges in the "Discharged To" column in the "Referrals and Discharges” section.
{20002.10} EEQ {20004.30}

Current Worksheet

Filter : Critical Errors
Sequence Identifier Level Error Left Value Operator Right Value

[ isommen | ol | 5|

Rule

The total of discharges in the "Length of Stay" section must match the total of discharges in the "Discharged To" column in the

Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or
it can be done for all worksheets by unchecking the box.
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You can fix an error and then re-run the validation by clicking on the refresh circle.

Current Worksheet Refresh ¥
Filter : Critical Errors ~  Export as Excel

If you have passed the validation edits you will have no error boxes checked and get a green message that
says Rule Passed Validation for each cell you choose.

Finalizing the Statistical Report

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the
Finalize Report icon.

C?;J‘:_& E E Eil: u VALIDATE CURRENT WORKSHEET v 8 j @@ ,«ijg Q

Or click Action on the top tool bar and choose “Finalize Report”
oZ File Edit View Configure Notes Windows Search Help

A message will come up asking if you are sure you want to save and finalize. Click Yes.
A second message will come up directing you to correct errors (if there are any) or letting you know that the
report has been finalized.

Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved
(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data
Gateway. You may wish to make a new folder on your desktop and save it there.

You will save a PDF of the report, as well as a .pnp file of the report.

The name of the report will be:
LHCSA_Agency Name_(Agency License Number)_Statewide_2023_A00.pnp

The file you will want to upload will end in “.pnp”

Your report is now ready to be submitted to the Healthcare Financial Data Gateway.

Submitting the Finalized LHCSA Statistical Report to the Healthcare Financial Data Gateway
1. Login to the HCS.

2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the
Healthcare Financial Data Gateway main page.
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Healthcare Financial Data Gateway

Mew York State Department of Health Wome | Contact | e

EVAL EVAL EVAL

Hosme Subsnisiaons Paiblications Rapars Administraics

Welcome to the Healthcare Financlal Data Gateway
The navigation bar above contains selectable tabs fof sach funclional area of the appboatien and is used 1o navigate throughout the application.
Piease read the descrpbon s of these areas below:
Software: The “Software” tab is vsed fo download the Cost Repoet software and supporting documentation. Hems selected for
download will be seved as a nip file
Submissions:  The “Subemisseons” tab can be used 1o do ey of the folowing

= Submat your comgleled and inalized Cost Repoe
= Wigw the détals of past subfessions
= Cortify 3 previously submitted Cost Report

Publications: The Publications” tab s wsed to download addtional information distnbuted by the Depatment of Health that 5 ot
duactly refated to the distribution of the Cost Report softwans

Reports: Thi “Repots” tab is used 1o sccess a downloadable history of submission and cerificatson detads for the Cost Reporis
Administration: The “Adeinistration” tab can be vsed 1o do arry of the fallowing

= Grani parressions o the appications

= hianage Roles

= Sef Submission CutOff

= Uplcad Scltware, Repors, and Supporting Doecumentatson
= Upload Certifications

2014 WS Department of Healts

3. Click the Submissions tab — the Submissions page will display.

Healthcare Financial Data Gateway Weleome John P Huffaker
- New York State Department of Health Home | Contact | Reguest Access | Help
L4
Home Software Submissions Publications Reports Administration
SUBMISSIONS
Select Cost Report And Organization
Submission Type: LHCSA j Organization: 00 Test LHCSA (D00000LC) j ‘Search
B 2014 NY'S Department of Health System Information

4. Select LHCSA as the Submission Type and your organization from the Organization list and then
click the Search button. The Submission page will be expanded.
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& Healthcare Financial Data Gateway Weleame John P Huffsker
:

New York State Department of Health Home | Contact | ReguestAccess | Help
Home Software Submizzions Publications Reports Administration
SUBMISSIONS
Select Cost Report And Organization
Submission Type: LHCSA j Organization: 00 Test LHCSA (000000LC) j Search

New Submission

Email: john.huffaker@heatth.ny.gov [Update email address}  Refrzsh Email
Uplead File: Browse. .. | No file selected.
Submit

Submiz=ion History

Report Period : 2017-Annual
. R e T = R
--Year | Period

12017 Statewide 08202018113309 08-20-2018 12:47:21 John P Failure Detsil
L Annud Huffaker —J
Statewide 08202018113309 08-20-2018 11:34:30 John P Success Detail Dommiond
Huffaker e
Statewide 08-20-2018 11:30:59 John P Failure i
Datail
Huffaker _J

5. Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA Statistical
Report. It will have a .pnp file extension.

6. Once you have selected the file to submit, click the Submit button.

7. The Submission History section of the Submission page will be updated to reflect the status of the
submission.

8. A confirming email message will be sent to the email address listed in the New Submission section of
the Submission page.
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Attachment A — Report Tool Bar items

Worksheets

Worksheets

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application
window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view
that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to
collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix
Panel.

Title Bar

Title Bar

The Title Bar is located at the very top of the window and will display the name, version and software build
number, followed by the name of the active-matrix table if a table is currently open.

E Universal Data Collection Systern - Version 5.0.0 - Build 20130306:152%43 - [FIDA_001_010]
Menu Bar
UDCS Menu bar

File Edit View Configure Action MNotes Windows 5earch Help
The following Help Topics will guide you through the menu bar functionality.

File
The File Menu.
File | Edit View Configure .

Report Manager Ctri+R
New Ctrl+N
Open Ctrl+0
Save Ctrl+5
Save Copy To ... I
Print b
Close Report i
Exit Program i

Report Manager: Select Report Manager to return to the Report Manager.
New: This command will start a new Report

Open: This command will enable you to open an existing Report
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Save: This will save the Report you are working on.

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location
that you choose. Your working report location will remain in the default location:
C:\ProgramData\UDCS\report

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel document
or a PDF document. For either option, the Select Worksheets window will open. Check the worksheets you
wish to export or check Select All to check all of the worksheets. You will be prompted to save the export
file to a location you choose. You can then open the file from this saved location and print.

Close Report: Closes the Report. You will be prompted to save your data first.

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data
first.

Edit
The Edit Menu

Cut, Copy, Paste, Undo

Edit | View Configut
Cut Ctri+X

Copy Ctrl+C
Paste Ctrl+V

Undo Ctrl+Z

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel
to your Report with some limitations:

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to
numeric type cells.

2) You may not paste data into read only cells such as targets of formulas.
3) You may select a range of cells to copy. However, when you paste the cells, the range size must match.
If the range size does not match, you will not be allowed to copy the data.

For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has
read only cells, you will be alerted to adjust your range.

View

The View Menu

Send questions to hcstatrpts@health.ny.gov pg. 31



View | Configure Action MNotes Windows 5e

Report Type b
Worksheet Panel (Expand-Collapse) Alt+W

Previous Worksheet Alt+Up

Mext Worksheet Ak+Down
Detail Panel (Expand-Collapse) Alt+D

Calculations (In Pop-Up Viewer)
Text Transfers {In Pop-Up Viewer)
Validation Results (In Pop-Up Viewer)

Submission Output (In Pop-Up Viewer)

Report Type: You can choose to Select All Worksheets to display all of the worksheets in the Report in the
Worksheet display panel. For Reports that have multiple Report Types, you may choose to select only the
worksheets from the selected Report Type.

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to
collapse the worksheet panel when you are working on a large worksheet and could use extra space to see
more of the worksheet.

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to
expand the worksheets.

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets.

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works
similarly to expand-collapse worksheets.

The following menu items will each open a window that will enable you to Export the data as a text file.
Calculations: A window will open that list all of the mathematical expressions in the Report.

Text Transfers: Lists all of the Text Transfers in the Report.
Text Transfers consist of a value and a target. Once the value is entered, the target
automatically gets populated with the same value.

Validation Rules: Lists all of the Validation Rules in the Report.
Validation Rules are conditions that must be met in order for the report to be completed
satisfactorily.

Submission Output: This is the XML output of the Report. It lists Report configuration information
as well as class code/line numbers and the values that were entered for them.

Configure

The Configure Menu
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Configure | Action Notes
Control Data F2

Report Settings F3
Report Types F4

Control Data: Contains information that is required in order for the Report to be completed correctly and
allowed to be submitted. All required Control Data fields must be complete. Required fields will have a red
exclamation point next to them. When you open the Report, you will be alerted if the Control Data
information is not completely filled out.

Report Settings / Report Types: These menu items are merely instructions to remind you what to do in the
event that you have created your report using the wrong configuration information, such as the wrong Report
Type or wrong Region. Click on the File menu to Start a New Report. Select the correct settings and then
transfer your data from the incorrect Report to the new Report.

Action

The Action Menu

Action | Notes Windows Sear
Validation Method b

Start Validating F5
Stop Valldating  Ctrl+F5

Finalize Report Fé6

Recalculate Formulas F7

Validation Method: Current Worksheet or Entire Report.

In order to Finalize the Report for Submission you must run it through the validation process. You can
validate to check only the current Worksheet, or you can run Validation for the entire Report. You must
Validate the entire Report in order to pass Validation and have a Finalized Report that is ready to submit.

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire
Report you can select the Start Validating item. For larger Reports, you may choose to Stop Validating at
any time.

Notepad
The Notepad Menu
This is a scratch pad to keep notes and provide additional information while you complete your report. Click

the File menu and then Save to save Notes to your Report. Use the File and Edit menu as you would a
typical text editor.

Windows

The Windows Menu
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Use the Windows commands to arrange the Worksheets to your satisfaction.
Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet
to bring it to the front of the Report.

Windows | Search

Cascade
Horizontal
Vertical

Close All
Worksheets »

Search
The Search Menu

Enter what you would like to search for in the Search box and click the Search button.
All results that match your Search criteria will be listed below. You may choose to Search
the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window.

Help
The Help Menu

View Documentation will open the Help File that you are currently reading.

Help |

View Documentation F1

About Universal Data Collection System (UDCS) F12

Click About to open the following window. This information contains details about the Report you have open
as well as the versions of the software and files being used.
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Icon Menu

Icon Menu

&

Open the Control Data Form.

Start a New Report.

Open an Existing Report.

s s Y

Save the Report.

i

23 Close the Report.

Validate the Current Worksheet or the Entire Report.

Stop the Validation process.

==
O Finalize the Report.

S

::»A Open Notepad.

©Open the Previous Worksheet.
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@ Open the Next Worksheet.

E

Export the Worksheet as a PDF document.

Export the Worksheet as an Excel file.

Open the Search Window.
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